XControl:ls XControl? Property

Short Name: Is XControl?

Installed With: Base Package

Class: Control Properties

Returns TRUE if the control is an XControl, FALSE otherwise.




Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System
Permissions Read
Only
Settable when the VI is running No
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions No
Available with polymorphic Vs No




Control Properties
Installed With: Base Package

Inherits from Generic»GObject. View the class hierarchy.

Property Description

Blinking If TRUE, the control blinks. Details

Caption Reference to the caption object. Details

Data Returns the type of binding. The binding type can

Binding:Binding
Type

be Unbound, Bound To PSP URL, or Bound To
Variable Shortcut. Details

Data Binding:LED
Visible

Shows or hides the data binding indicator. Detalils

Data Binding:Mode

Gets or sets the mode of the data connection. The
data connection mode can be No PSP, Read, Write,
or Write & Read. Detalls

Data Binding:Path

Reads or writes the NI Publish-Subscribe-Protocol
URL to which the control is connected. To write this
property, you must bind the control to the PSP URL
before you begin writing. Details

Data Binding:Status

Returns the status of the data connection. The
connection status can be Invalid Status,
Unconnected, Active, Idle, Error, or Connecting.
Details

DataSocket:Enabled

This is the enabled state of the opc, ftp, and http
connection on Windows, and the dstp and file
connection on all LabVIEW-supported platforms. A
connection can transfer data only when enabled.
Details

DataSocket:LED
Visible

Shows or hides the connection status indicator.
Details

DataSocket:Mode

Gets or sets the mode of the data connection.
Details

DataSocket:Status

Returns the status of the data connection. The
connection status can be Invalid Status,
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Unconnected, Active, Idle, Error, or Connecting.
Details

DataSocket;:URL

Gets or sets the URL to which the control is
connected. Valid URLSs for using the DataSocket
properties to connect controls are the opc, ftp, and
http protocols on Windows, and the dstp and file
protocols on all LabVIEW-supported platforms.
Details

Description Description of the front panel object that appears in
the Context Help window when you move the
cursor over the object and in VI documentation you
generate. Details

Disabled Indicates if control can be operated: 0-Enabled, 1-

Disabled, 2-Disabled and Grayed Out. Details

Focus Key Binding

Sets a shortcut key to navigate to this control.
Details

Indicator If TRUE, the front panel object is an indicator. If
FALSE, the object is a control. Details

Key Focus If TRUE, the control has key focus and receives
the keys pressed on the keyboard. Details

Label Reference to the label object. Details

Skip When Tabbing

If TRUE, LabVIEW skips this control when you tab
through the front panel. Details

Synchronous Defers updates for controls or indicators. Details
Display
Tip Strip Sets or returns the tip strip of a control. A tip strip is

the brief description of the front panel object that
appears when you move the cursor over the
object. Details

Value (Signaling)

Sets the value of the control (LV variant) and
generates a Value Change event. Details

Value (Signaling)

Sets the value of the control and generates a
Value Change event. Details

Value

Data value of this control. If this is a Boolean value
configured with a latching mechanical action, this
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property always returns an error. Due to race
conditions that can occur when you have a
Boolean value with latching mechanical action, you
cannot programmatically read Boolean values that
are set with a latching mechanical action. Details

Value

Data value of the control (LV variant). If this is a
Boolean value configured with a latching
mechanical action, this property always returns an
error. Due to race conditions that can occur when
you have a Boolean value with latching
mechanical action, you cannot programmatically
read Boolean values that are set with a latching
mechanical action. Details

Visible

Displays the front panel control. Details

XControl:Container
Bounds

Sets or gets the container bounds of the XControl.
Details

XControl:Container
Bounds:Height

Height of the XControl. Details

XControl:Container

Width of the XControl. Details

Bounds:Width
XControl:ls Returns TRUE if the control is an XControl, FALSE
XControl? otherwise. Details




VI Server Property and Method Characteristics

The following list defines the characteristics for each property and
method.

Settable when the VI is running—Specifies if you can write a
value to this property or method when the VI is running. If this
characteristic value is No, LabVIEW returns error 1000 or 1073 if
you try to write a value when the VI is running. This characteristic
does not apply to the properties and methods in the Application
class.

Need to authenticate before use—Specifies if you need to
authenticate the VI before you can use the property or method.
For example, you might need to unlock a password-protected VI
before using a method with a characteristic value of Yes. If this
characteristic value is Yes, LabVIEW returns error 1040 or 1044 if
you did not authenticate the VI.

Loads the block diagram into memory—Specifies if LabVIEW
loads the block diagram into memory. If this characteristic value is
Yes, LabVIEW returns error 1012 if the block diagram cannot be
loaded into memory. This characteristic does not apply to the
properties and methods in the Application class.

Remote access disallowed—Specifies if access to this property
or method is disallowed with a permission error by a remote
application instance. If this characteristic value is Yes, LabVIEW
returns error 1032 if you try to use a remote reference to this
property or method.

Loads the front panel into memory—Specifies if LabVIEW
loads the front panel into memory. If this characteristic value is
Yes, LabVIEW returns error 1013 if the front panel cannot be
loaded into memory. This characteristic does not apply to the
properties and methods in the Application class.

Must wait until user interface is idle—Specifies if you can use
this property or method while the user is selecting items in a
dialog box, tracking a control, and so on.

Available with control VIs—Specifies if you can use this

property or method with VIs that are controls. If this characteristic
value is No, LabVIEW returns error 1035 if you use this property
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or method with VIs that are controls. This characteristic applies
only to the properties and methods in the VI class.

Available with global VIs—Specifies if you can use this property
or method with VIs that are globals. If this characteristic value is
No, LabVIEW returns error 1035 if you use this property or
method with VIs that are globals. This characteristic applies only
to the properties and methods in the VI class.

Available with strict type definitions—Specifies if you can use
this property or method with strict type definitions. This
characteristic does not apply to the properties and methods in the
Application and VI classes.

Available with polymorphic Vis—Specifies if you can use this
property or method with polymorphic VIs. If this characteristic
value is No, LabVIEW returns error 1035 if you use this property
or method with polymorphic VIs. This characteristic applies only
to the properties and methods in the VI class.

Available in Run-Time Engine and Real-Time Operating
System—Specifies if you can use this property or method in built
applications and in the Real-Time Operating System. The value
in parentheses indicate the permission for the property or method
in the Run-Time Engine and Real-Time Operating System.
Values include Read Only, Write Only, Read/Write,
WriteInEditOnly, or no. Some properties and methods are only
available during editing. If this characteristic value is No,
LabVIEW returns error 1043 if you use this property or method in
built applications.

Permissions—Specifies if this property is Read Only, Write Only,
Read/Write, or WriteInEditOnly. If the property is WriteInEditOnly,
you can write to the property only when the VI is in edit mode.
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Generic Properties
Installed With: Base Package

View the class hierarchy.

You can set these properties on controls.

Property|Description

Class ID |Class identifier of the object. Details

Class Name of the VI Server class that contains the object. Details

Name

Owner |Reference to the owning Object. The type of the reference is
Generic. An object of class Panel does not have an owner (it
is the top-level object) and always returns Not A Refnum.
Details

Owning |Returns a reference to the VI that owns this object. Close this

Vi reference when you are finished using it. The reference this

property returns does not keep the VI in memory. If the owning
VI is removed from memory, this reference becomes invalid.
Use the Open VI Reference function to obtain a reference to a
VI that stays in memory until you explicitly close the reference.
Details
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GObject Properties
Installed With: Base Package

Inherits from Generic. View the class hierarchy.

Property

Description

Bounds

Maximum bounding area of the object specified in terms of
width and height in pixels. Details

Bounds:Area
Height

Height of the maximum bounding area of the object in
pixels. Details

Bounds:Area
Width

Width of the maximum bounding area of the object in
pixels. Details

Position

Position of the top left corner of the bounding rectangle of
the object on the front panel window in terms of left and
top coordinates. Details

Position:Left

Position of the left corner of the bounding rectangle of the
object on the front panel window. Detalils

Position:Top

Position of the top corner of the bounding rectangle of the
object on the front panel window. Detalils




VI Server Class Hierarchy

All properties, methods, and events belong to a class. Classes are
arranged in a hierarchy with each class inheriting the properties,
methods, and events associated with the class in the preceding level. For
example, a button is a member of the Boolean class, which has a set of
properties unique to it, such as the button height and width. In addition,
all Booleans are members of the Control class, which includes the
properties found in most other front panel controls and indicators, such
as the Visible, Label, and Default Value properties.

For each class below, click p to view the associated properties, m to view
the associated methods, and e to view the associated events.
Application (p,
m, e)
VI (p, m, €)
FacadeVI (p, m,
€)
MethodVI (p, m)
PolymorphicVI (p,
m)
Project (p, m)
Projectltem (p,
m)
BuildSpecification
(0, m)
Library (p, m)
LVClassLibrary
(0, m)
XlnterfaceLibrary
(m)
XControlLibrary (p,
m)
PropertyFolder
(m)
XPropertyFolder
()
Targetltem (p, m)
Generic (p, m)
Cursor (p, m)
GObject (p, m)
Control (p, m, €)
AbsTime (p, m)



ActiveXContainer
(p, m)

Array (p, m)
Boolean (p, m)
|Cluster (p, m)

RadioButtonsControl

()

|COI0rBox (p, m)
DDigitalTable (p, m)

GraphChart (p, m,
e)

IntensityChart (p, m)
IntensityGraph (p,
m, )
MixedSignalGraph
(p, m)
WaveformChart (p,
m)

WaveformGraph (p,
m, €)

IOName (p, m, €)

DAQChannelName
(0, m)
'IDAQmxName (p, m)
IDSCTag (p, m)

IVILogicalName (p,
m)

VISAResourceName
(p, m)

|ListBox (p, m, €)
'LVVariant (p, m)
'MixedCheckbox (p)
MulticolumnListbox
(p, m, €)
MultiSegmentPipe
()

'Numeric (p, m, e)

|Co|0rRamp (p, M)

Digital (p, m)

NamedNumeric (p,
m, )




NumericWithScale
(p, m)

PageSelector (p, m)
"TabControl (p, m)

Path (p, m)
PPicture (p, m)
|RefNum (p, m)

TypedRefNum (p,
m)

LVObjectRefNum (p,
m)

SceneGraphDisplay
(0, m)

|Scr0||bar (9)
'SubPanel (p, m)
String (p, m, €)

|C0mboBox (p, m, €)

Table (p, m)
TreeControl (p, m,
€)

WaveformData (p,
m)

IDecoration (p, m)
Text (p, m)

NumericText (p, m)

Pane (p, m, €)
|Pane| (p, m)
|Sca|e (p, m)

\ColorScale (p, m)

RotaryColorScale
(p, m)

ColorGraphScale
(p, m)
(GraphScale (p, m)
|




Splitter (o, m, €)

Page (o, m)
Plot (p, m)

\Variable (p, m)

SceneTexture (p,
m)
SceneNode (p,
m)
SceneClipPlane
(, m)
|SceneLight (p, m)
SceneObject (p,
m)
SceneDrawable
(, m)
SceneGeometry
(, m)
|SceneBox (p, m)
SceneCone (p,
m)
SceneCylinder
(, m)
SceneHeightField
(, m)
SceneMesh (p,
m)
SceneSphere (p,
m)
|SceneText (p, m)
SceneWindow(p,

m)

'SlideScale (p, m)




Blinking Property
Short Name: Blinking
Installed With: Base Package
Class: Control Properties

If TRUE, the control blinks.

If you set this property to TRUE for system controls, the controls might
not blink correctly. System controls are designed specifically for use in
dialog boxes and are not designed to blink because standard dialog
boxes usually do not contain blinking controls. Also, you cannot use this
property with XControls or controls on a subpanel.

This property is similar to the Blink Foreground and Blink Background
options on the Colors page of the Options dialog box.
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Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Caption Property
Short Name: Caption
Installed With: Base Package
Class: Control Properties

Reference to the caption object.
You can use this reference with the Text properties.

This property is similar to the Visible Items»Caption option on the
shortcut menu of front panel controls and the Caption Visible and
Caption Text options on the Appearance page of the Properties dialog
box.
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Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System
Permissions Read
Only
Settable when the VI is running No
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Data Binding:Binding Type Property
Short Name: BindingType
Installed With: Base Package

Class: Control Properties

Returns the type of binding. The binding type can be Unbound, Bound To
PSP URL, or Bound To Variable Shortcut.




Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System
Permissions Read
Only
Settable when the VI is running No
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Data Binding:LED Visible Property
Short Name: BindingLEDVisible

Installed With: Base Package

Class: Control Properties

Shows or hides the data binding indicator.




Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Data Binding:Mode Property
Short Name: BindingMode

Installed With: Base Package

Class: Control Properties

Gets or sets the mode of the data connection. The data connection mode
can be No PSP, Read, Write, or Write & Read.




Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Data Binding:Path Property
Short Name: BindingPath

Installed With: Base Package

Class: Control Properties

Reads or writes the NI Publish-Subscribe-Protocol URL to which the
control is connected. To write this property, you must bind the control to
the PSP URL before you begin writing.

Note If the control is bound to a project item instead of a PSP
URL and you attempt to write this property, this property returns an
error.

To bind the control to a PSP URL, use the Bind to Network Path method
while the VI is not running.
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Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Data Binding:Status Property
Short Name: BindingStatus
Installed With: Base Package

Class: Control Properties

Returns the status of the data connection. The connection status can be
Invalid Status, Unconnected, Active, Idle, Error, or Connecting.




Elements

Name Description

Code |The connection status. Valid values are Invalid Status,
Unconnected, Active, Idle, Error, or Connecting.

Text |Displays a message describing the current status.




Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System
Permissions Read
Only
Settable when the VI is running No
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




DataSocket:Enabled Property

Short Name: DtSktEnbld
Installed With: Base Package
Class: Control Properties

This is the enabled state of the opc, ftp, and http connection on Windows,
and the dstp and file connection on all LabVIEW-supported platforms. A
connection can transfer data only when enabled.
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Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




DataSocket:LED Visible Property
Short Name: DtSktLEDVisible

Installed With: Base Package

Class: Control Properties

Shows or hides the connection status indicator.




Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




DataSocket:Mode Property
Short Name: DtSktMode

Installed With: Base Package

Class: Control Properties

Gets or sets the mode of the data connection.




Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




DataSocket:Status Property
Short Name: DtSktStatus
Installed With: Base Package

Class: Control Properties

Returns the status of the data connection. The connection status can be
Invalid Status, Unconnected, Active, Idle, Error, or Connecting.




Elements

Name Description

Code |The connection status. Valid values are Invalid Status,
Unconnected, Active, Idle, Error, or Connecting.

Text |Displays a message describing the current status.




Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System
Permissions Read
Only
Settable when the VI is running No
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




DataSocket:URL Property

Short Name: DtSktURL
Installed With: Base Package
Class: Control Properties

Gets or sets the URL to which the control is connected. Valid URLSs for
using the DataSocket properties to connect controls are the opc, ftp, and
http protocols on Windows, and the dstp and file protocols on all
LabVIEW-supported platforms.

To set the URL, use the Attach DataSocket and Remove DataSocket
methods when the VI is not running. Use front panel data bindings to bind
controls to shared variables or to NI Publish-Subscribe-Protocol data
items.
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Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Description Property

Short Name: Desc
Installed With: Base Package
Class: Control Properties

Description of the front panel object that appears in the Context Help
window when you move the cursor over the object and in VI
documentation you generate.

You can format the text in the description to appear bold in the Context
Help window.

If you want to display a carriage return in the Context Help window, you
must separate paragraphs with two carriage returns

This property is similar to the VI description text box on the
Documentation page of the VI Properties dialog box.



lvhowto.chm::/CreatingEditing_VI_Desc.html
lvhowto.chm::/bold_context_help_text.html
lvdialog.chm::/Documentation_Properties.html
lvdialog.chm::/VI_Properties_Dialog_Box.html

Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Disabled Property
Short Name: Disabled
Installed With: Base Package
Class: Control Properties

Indicates if control can be operated: 0-Enabled, 1-Disabled, 2-Disabled
and Grayed Out.

This property is similar to Advanced»Enabled State item on the shortcut
menu of a front panel control or indicator and to the Enabled State
option on the Appearance page of the Properties dialog box.

Examples
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Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Examples
Refer to the following VIs for examples of using the Disabled property:

e Showing and Hiding Options VI:
labview\examples\general\cntrlref.llb

21 Open example = Browse related examples
e String Property Node VI: labview\examples\general\cntrlref.llb
21 Open example = Browse related examples


javascript:openVI('examples%5C%5Cgeneral%5C%5Ccntrlref.llb%5C%5CShowing%20and%20Hiding%20Options.vi');
javascript:findExamples(3172);
javascript:openVI('examples%5C%5Cgeneral%5C%5Ccntrlref.llb%5C%5CString%20Property%20Node.vi');
javascript:findExamples(3172);

Focus Key Binding Property
Short Name: FocusKeyBind

Installed With: Base Package

Class: Control Properties

Sets a shortcut key to navigate to this control.

This property is similar to the Focus option on the Key Navigation page
of the Properties dialog box.
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Elements

Name Description

Control|If TRUE, the keyboard shortcut includes the <Ctrl> key.

Shift  |If TRUE, the keyboard shortcut includes the <Shift> key.

Key |The name of the shortcut key.(Mac OS) LabVIEW does not
support <VolumeUp>, <VolumeDown>, and function keys <F15>
to <F24> as shortcut keys on Mac OS. Key must match one of
the following values:

e <Clear>

e <|ns>

e <Del>

e <Home>

e <End>

e <PageUp>

e <PageDown>

o <Escape>

e <Enter>
Note The <Enter> key on the alphanumeric
keyboard and <Enter> key on the numeric
keypad are the same value.

o <Play>

e <VolumeUp>

e <VolumeDown>

e <Mute>

e F1

e F2

e F3

e F4

e 5

e F6

o F7

e 8




e F9

e F10
e F11
e F12
e F13
o F14
e F15
e F16
o F17
e F18
e F19
e 20
o F21
o 22
o 23
o F24

Note You must use the English Key name when wiring a
shortcut key value.




Remarks
The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory Yes
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Indicator Property
Short Name: Indicator
Installed With: Base Package
Class: Control Properties

If TRUE, the front panel object is an indicator. If FALSE, the object is a
control.




Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating |Yes (Read

System Only)

Permissions Write In Edit
Only

Settable when the VI is running No

Loads the front panel into memory No

Need to authenticate before use No

Loads the block diagram into memory No

Remote access disallowed No

Must wait until user interface is idle No

Available with control Vis No

Available with global Vs No

Available with strict type definitions Yes

Available with polymorphic Vs No




Key Focus Property
Short Name: KeyFocus
Installed With: Base Package
Class: Control Properties

If TRUE, the control has key focus and receives the keys pressed on the
keyboard.

Example




Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Example

Refer to the String Property Node VI in the
labview\examples\general\cntrlref.llb for an example of using the Key Focus

property.
21 Open example = Browse related examples


javascript:openVI('examples%5C%5Cgeneral%5C%5Ccntrlref.llb%5C%5CString%20Property%20Node.vi');
javascript:findExamples(3172);

Label Property

Short Name: Label

Installed With: Base Package

Class: Control Properties

Reference to the label object.

You can use this reference with the Text properties.



lvprop.chm::/Text_p.html

Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System
Permissions Read
Only
Settable when the VI is running No
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Skip When Tabbing Property
Short Name: SkipTabbing

Installed With: Base Package

Class: Control Properties

If TRUE, LabVIEW skips this control when you tab through the front
panel.

This property is similar to the Skip this control when tabbing option on
the Key Navigation page of the Properties dialog box.



lvhowto.chm::/Setting_Keyboard_Shortcut.html
lvhowto.chm::/ConfigControlsandIndicator.html

Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Synchronous Display Property
Short Name: SyncDisp

Installed With: Base Package

Class: Control Properties

Defers updates for controls or indicators.

In multithreaded systems, you can use the Synchronous Display property
to set whether to defer updates for controls and indicators. This property
is similar to the Advanced»Synchronous Display option on the shortcut
menu of block diagram controls and indicators.



Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating |Yes (Read

System Only)

Permissions Write In Edit
Only

Settable when the VI is running No

Loads the front panel into memory No

Need to authenticate before use No

Loads the block diagram into memory No

Remote access disallowed No

Must wait until user interface is idle No

Available with control Vis No

Available with global Vs No

Available with strict type definitions Yes

Available with polymorphic Vs No




Tip Strip Property
Short Name: TipStrip
Installed With: Base Package
Class: Control Properties

Sets or returns the tip strip of a control. A tip strip is the brief description
of the front panel object that appears when you move the cursor over the
object.



lvhowto.chm::/Creating_VI_and_Object_De.html

Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Value (Signaling) Property
Short Name: Val(Sgnl)

Installed With: Base Package

Class: Control Properties

Sets the value of the control (LV variant) and generates a Value Change
event.

This property updates the value of an object similar to the Value property.
However, Value (Signaling) also causes LabVIEW to generate an event
as if the user had interactively changed the value of the object. National
Instruments recommends you use this property only when you rely on
LabVIEW generating an event in response to the programmatic value
change.

If this is a Boolean value configured with a latching mechanical action,
this property always returns an error. Due to race conditions that can
occur when you have a Boolean value with latching mechanical action,
you cannot programmatically read Boolean values that are set with a
latching mechanical action.


lvprop.chm::/Ctrl_Value_Changed.html
lvprop.chm::/Control_Value.html
lvhowto.chm::/EventsDirectUIOnly.html

Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System
Permissions Write
Only
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Value (Signaling) Property
Short Name: Val(Sgnl)

Installed With: Base Package

Class: Control Properties

Sets the value of the control and generates a Value Change event.

This property updates the value of an object similar to the Value property.
However, Value (Signaling) also causes LabVIEW to generate an event
as if the user had interactively changed the value of the object. National
Instruments recommends you use this property only when you rely on
LabVIEW generating an event in response to the programmatic value
change.

If this is a Boolean value configured with a latching mechanical action,
this property always returns an error. Due to race conditions that can
occur when you have a Boolean value with latching mechanical action,
you cannot programmatically read Boolean values that are set with a
latching mechanical action.


lvprop.chm::/Ctrl_Value_LV_Var.html
lvhowto.chm::/EventsDirectUIOnly.html

Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System
Permissions Write
Only
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Value Property

Short Name: Value

Installed With: Base Package
Class: Control Properties

Data value of this control. If this is a Boolean value configured with a
latching mechanical action, this property always returns an error. Due to
race conditions that can occur when you have a Boolean value with
latching mechanical action, you cannot programmatically read Boolean
values that are set with a latching mechanical action.



Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Value Property

Short Name: Value

Installed With: Base Package
Class: Control Properties

Data value of the control (LV variant). If this is a Boolean value
configured with a latching mechanical action, this property always returns
an error. Due to race conditions that can occur when you have a Boolean
value with latching mechanical action, you cannot programmatically read
Boolean values that are set with a latching mechanical action.




Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Visible Property
Short Name: Visible

Installed With: Base Package
Class: Control Properties

Displays the front panel control.

This property is similar to the Show Control and Hide Control options on
the shortcut menu of a control.



lvhowto.chm::/DisplayingHiddenFPObjects.html
lvhowto.chm::/Hiding_Front_Panel_Control.html

Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




XControl:Container Bounds Property
Short Name: Container Bounds

Installed With: Base Package

Class: Control Properties

Sets or gets the container bounds of the XControl.




Elements
XControl:Container Bounds:Width
XControl:Container Bounds:Height



lvprop.chm::/Ctrl_XCtrlCntnr_BndsWidth.html
lvprop.chm::/Ctrl_XCtrlCntnr_BndsHeight.html

Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions No
Available with polymorphic Vs No




XControl:Container Bounds:Height Property
Short Name: Height

Installed With: Base Package

Class: Control Properties

Height of the XControl.

This property is an element of the XControl:Container Bounds property.



lvprop.chm::/Ctrl_XCtrlContainer_Bounds.html

Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions No
Available with polymorphic Vs No




XControl:Container Bounds:Width Property
Short Name: Width

Installed With: Base Package

Class: Control Properties

Width of the XControl.

This property is an element of the XControl:Container Bounds property.



lvprop.chm::/Ctrl_XCtrlContainer_Bounds.html

Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions No
Available with polymorphic Vs No




Class ID Property
Short Name: ClassID
Installed With: Base Package
Class: Generic Properties
Class identifier of the object.

This integer uniquely identifies the class of a LabVIEW object. To view
the corresponding class name of a LabVIEW object, use the Class Name

property.



lvprop.chm::/Gen_Class_Name.html

Values

Generic

Decoration

Text

Control

ColorBox

Boolean

RefNum

Variant

Path

ListBox

Table

Array

Picture

ActiveXContainer

Numeric

Digital

NamedNumeric

ColorRamp

Slide

GraphOrChart

WaveformChart

WaveformGraph

IntensityChart

IntensityGraph

String

IOName

ComboBox

Cluster




31

Panel

32

Knob

33

NumWithScale

34

Ring

35

Enum

36

GObiject

37

Plot

38

Cursor

39

NumericText

40

Scale

41

ColorScale

42

GraphScale

43

ColorGraphScale

44

TypedRefNum

45

OldKnobScale

46

MCListbox

47

MeasureData

48

BVTag

49

DAQName

50

VISAName

51

IVIName

52

SlideScale

53

TabControl

54

Page

55

TabArrayTabControl

56

ConPane




Remarks
The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating |Yes (Read
System Only)
Permissions Read Only
Settable when the VI is running No

Loads the front panel into memory No

Need to authenticate before use No

Loads the block diagram into memory No
Remote access disallowed No

Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions No
Available with polymorphic Vs No




Class Name Property

Short Name: ClassName

Installed With: Base Package

Class: Generic Properties

Name of the VI Server class that contains the object.




Remarks
The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating |Yes (Read
System Only)
Permissions Read Only
Settable when the VI is running No

Loads the front panel into memory No

Need to authenticate before use No

Loads the block diagram into memory No
Remote access disallowed No

Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions No
Available with polymorphic Vs No




Owner Property
Short Name: Owner

Installed With: Base Package
Class: Generic Properties

Reference to the owning Object. The type of the reference is Generic. An
object of class Panel does not have an owner (it is the top-level object)
and always returns Not A Refnum.



Remarks
The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating |Yes (Read
System Only)
Permissions Read Only
Settable when the VI is running No

Loads the front panel into memory No

Need to authenticate before use No

Loads the block diagram into memory No
Remote access disallowed No

Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions No
Available with polymorphic Vs No




Owning VI Property
Short Name: OwningVI
Installed With: Base Package
Class: Generic Properties

Returns a reference to the VI that owns this object. Close this reference
when you are finished using it. The reference this property returns does
not keep the VI in memory. If the owning VI is removed from memory, this
reference becomes invalid. Use the Open VI Reference function to obtain
a reference to a VI that stays in memory until you explicitly close the
reference.



glang.chm::/Open_VI_Reference.html

Remarks
The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating |Yes (Read
System Only)
Permissions Read Only
Settable when the VI is running No

Loads the front panel into memory No

Need to authenticate before use No

Loads the block diagram into memory No
Remote access disallowed No

Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions No
Available with polymorphic Vs No




Bounds Property
Short Name: Bounds
Installed With: Base Package
Class: GObject Properties

Maximum bounding area of the object specified in terms of width and
height in pixels.

For a front panel object, this property returns the dimensions of the
rectangle enclosing all the visible object components, such as the control,
caption, label, graph legends, and so on.

You cannot use this property to change the size of an object. To change
the size of an object programmatically, use more specific properties such
as Text Width or Plot Area:Size.



lvprop.chm::/Digi_Txt_Wdth.html
lvprop.chm::/GrphChrt_Plot_AreaSze.html

Elements
Bounds:Area Width
Bounds:Area Height



lvprop.chm::/GObj_BoundsWdth.html
lvprop.chm::/GObj_BoundsHeight.html

Remarks
The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating |Yes (Read
System Only)
Permissions Read Only
Settable when the VI is running No

Loads the front panel into memory No

Need to authenticate before use No

Loads the block diagram into memory No
Remote access disallowed No

Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Bounds:Area Height Property

Short Name: Area Height

Installed With: Base Package

Class: GObject Properties

Height of the maximum bounding area of the object in pixels.
This property is an element of the Bounds property.



lvprop.chm::/GObj_Bounds.html

Remarks
The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating |Yes (Read
System Only)
Permissions Read Only
Settable when the VI is running No

Loads the front panel into memory No

Need to authenticate before use No

Loads the block diagram into memory No
Remote access disallowed No

Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Bounds:Area Width Property

Short Name: Area Width

Installed With: Base Package

Class: GObject Properties

Width of the maximum bounding area of the object in pixels.
This property is an element of the Bounds property.



lvprop.chm::/GObj_Bounds.html

Remarks
The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating |Yes (Read
System Only)
Permissions Read Only
Settable when the VI is running No

Loads the front panel into memory No

Need to authenticate before use No

Loads the block diagram into memory No
Remote access disallowed No

Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Position Property

Short Name: Position
Installed With: Base Package
Class: GObject Properties

Position of the top left corner of the bounding rectangle of the object on
the front panel window in terms of left and top coordinates.

The bounding rectangle of the object includes all visible parts of the
object. For example, if the object label is visible and you wire the top
coordinate to this property, LabVIEW positions the top of the label at the
coordinate you wired. If the object label is not visible, LabVIEW positions
the top of the remaining visible parts of the object at the coordinate you
wired.

@ Note LabVIEW sets the origin for this property when you create a
VI. When you scroll the owning pane, the origin does not change
but instead scrolls with the owning pane. If you do not move the
object, this property returns the same coordinates for the object
regardless of whether you scroll the owning pane. Use the Origin
property with this property to calculate the current position of an
object in relation to the owning pane. For most front panel objects,
this property returns the position of the object relative to the origin
of the owning pane. For panes, this property returns the position of
the pane relative to the global panel coordinate system.

If you attempt to reposition an object that is grouped with other objects,
LabVIEW repositions only the object you specify, not the whole group.


lvprop.chm::/Pane_Origin.html

Elements
Position:Left

Paosition:Top


lvprop.chm::/GObj_PosLeft.html
lvprop.chm::/GObj_PosTop.html

Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Position:Left Property
Short Name: Left

Installed With: Base Package
Class: GObject Properties

Position of the left corner of the bounding rectangle of the object on the
front panel window.

This property is an element of the Paosition property.

@ Note For most front panel objects, this property returns the
position of the object relative to the origin of the owning pane. For
panes, this property returns the position of the pane relative to the
global panel coordinate system.


lvprop.chm::/GObj_Pos.html

Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Position:Top Property
Short Name: Top

Installed With: Base Package
Class: GObject Properties

Position of the top corner of the bounding rectangle of the object on the
front panel window.

This property is an element of the Paosition property.

@ Note For most front panel objects, this property returns the
position of the object relative to the origin of the owning pane. For
panes, this property returns the position of the pane relative to the
global panel coordinate system.


lvprop.chm::/GObj_Pos.html

Remarks

The following table lists the characteristics of this property.

Available in Run-Time Engine and Real-Time Operating Yes
System

Permissions Read/Write
Settable when the VI is running Yes
Loads the front panel into memory No
Need to authenticate before use No
Loads the block diagram into memory No
Remote access disallowed No
Must wait until user interface is idle No
Available with control Vis No
Available with global Vs No
Available with strict type definitions Yes
Available with polymorphic Vs No




Application Properties

Installed With: Base Package
View the class hierarchy.

Use the print properties to configure what is to be printed. Set all the
custom printing properties because they default to their previous settings.
To actually print VI information, you must use a VI Class print method.

Property

Description

Application:All VIs In Memory

Returns a list of VIs in memory for the
specified application instance. This
property returns an error if you wire a
remote application reference to the
reference input. For a remote
application, use the Exported VIs in
Memory property to return a list of
exported Vls. Details

Application:Command Line
Arguments

Returns an array of user-defined
command-line arguments passed when
LabVIEW launched. Details

Application:Debug Name

Returns the name used for opening a
debugging connection to this application
or shared library. This method is only
useful in built applications or shared
libraries. Details

Application:Default:Application

Returns the default application
reference. Details

Application:Default:Data
Directory

Path to the default data directory. Details

Application:Directory Path

Absolute path to the directory where the
application is located. Details

Application:Exported Vis In
Memory

Returns a list of exported VIs in memory.
Details

Application:Kind

Indicates the LabVIEW instance the VI is
running in, including invalid application
types. Details



lvprop.chm::/VI_m.html
lvconcepts.chm::/Application_Instances.html
lvprop.chm::/App_AppExport_VIs_In_Mem.html
lvhowto.chm::/Select_Default_Data_Fold.html

Application:Language

Indicates the language of the LabVIEW
environment or stand-alone application
as a string according to 1ISO 639. Values
include en, de, fr, ja, ko, and zh-cn.
Details

Application:Name

Filename of the application. Detalils

Application:Saveable Versions

An array of the LabVIEW versions to
which this version of LabVIEW can save.
The array is in reverse chronological
order, with the zeroth element being the
current version of LabVIEW. Each
element of the array is a valid version to
pass to VI server functions which save to
previous versions. Details

Application:Show FP Tip
Strips

Writing the property: Setting this property
to TRUE enables the display of tip strips
on front panel controls. Setting the
property to FALSE prevents them from
being displayed. Reading the property:
Specifies whether tip strips display when
idling over controls on the front panel.
Details

Application:Target:CPU

Indicates the target CPU of an
application. Details

Application:Target:Operating
System

Indicates the operating system for which
the application was built. Mac OS refers
to Mac OS versions 8 and 9. Carbon
refers to Mac OS X. Details

Application:User Interface
Available

If you are not targeted to a real-time (RT)
platform, this property is always TRUE. If
you are targeted to an RT-platform and
the host is connected, this property is
TRUE. When this property is FALSE, the
host is not connected, requiring that the
RT Module application must be able to
handle all operations independent of the
host. Use this property to determine




when it is safe to display a dialog box
that requires user interaction. Details

Application:User Name

User name used to open the application.
Details

Application:Version Number

Version number of the application. In a
built application or shared library, this
property returns the version of the
LabVIEW Run-Time Engine. Details

Debug Server:Server Active

Determines whether the Debug Server is
enabled. You can use this property only
in LabVIEW-built applications or shared
libraries. Details

Debug Server:TCP/IP Access
List

List that describes which TCP/IP
addresses of remote clients can access
the Debug Server. You can use this
property only in LabVIEW-built
applications or shared libraries. Details

Display:All Monitors

Returns information about all the
monitors on the computer, including their
bit depths and bounding rectangles.
Details

Display:Primary Workspace

Gives the bounding rectangle of the
computer's primary monitor. Details

NI Security:Nobody Logged
In?

Determines if anyone is logged in.
Details

NI Security:User

Indicates the name of the user who is
currently logged in, using the format of
<Domain Name>\<User Name>. Details

Operating System:Name

Name of the operating system where the
application is actually running. Details

Operating System:Version
Number

Version number of the actual operating
system. Details

Printing:Available Printers

Returns an alphabetized array of printer
names available on the computer.
Details




Printing:Color/Grayscale?

If TRUE, LabVIEW sends
color/grayscale output to the printer. If
FALSE, LabVIEW sends monochrome
output to the printer. Detalils

Printing:Custom All Controls?

Specifies whether to print all controls or
only the controls wired to the connector
pane when using the custom format with
one of the print documentation VI
methods. Details

Printing:Custom Connector?

Specifies whether to print the connector
pane and icon of VIs when using the
custom format with one of the print
documentation VI methods. Detalils

Printing:Custom Control
Descriptions?

Specifies whether to print descriptions of
front panel controls when using the
custom format with one of the print
documentation VI methods. Detalils

Printing:Custom Control
Label/Caption?

Specifies whether to print the label
and/or caption for each control when
using the custom format with one of the
print documentation VI methods. Details

Printing:Custom Control
Types?

Specifies whether to print data type
information for front panel controls when
using the custom format with one of the
print documentation VI methods. Details

Printing:Custom Controls?

Specifies whether to print front panel
control information when using the
custom format with one of the print
documentation VI methods. Detalils

Printing:Custom Description?

Specifies whether to print VI descriptions
when using the custom format with one
of the print documentation VI methods.
Details

Printing:Custom Diagram
Hidden?

Specifies whether to print the hidden
frames in Case and Stacked Sequence
structures that might be present on the
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block diagram when using the custom
format with one of the print
documentation VI methods. Details

Printing:Custom Diagram
Repeat?

Specifies whether to print visible
subdiagrams of each Case, Event, and
Stacked Sequence structure in sequence
with the non-visible subdiagrams when
using the custom format with one of the
print documentation VI methods. If you
print the visible subdiagrams in
sequence, those subdiagrams print
twice. Details

Printing:Custom Diagram?

Specifies whether to print block diagrams
when using the custom format with one
of the print documentation VI methods.
Details

Printing:Custom Express VI
Configuration?

Specifies whether to print the
configuration information for any Express
VIs on the block diagram when using the
custom format with one of the print
documentation VI methods. Details

Printing:Custom Hierarchy?

Specifies whether to print the hierarchy
of the VI in memory when using the
custom format with one of the print
documentation VI methods. Details

Printing:Custom History?

Specifies whether to print the VI revision
history information when using the
custom format with one of the print
documentation VI methods. Detalils

Printing:Custom List of
SubVIs?

Specifies whether to print a list of the
subVls and Express VIs including the
icon, name, and path when using the
custom format with one of the print
documentation VI methods. If a
polymorphic VI is a subVI, LabVIEW
prints the instance used in the top-level
VI including the icon, name, and path. If



lvprop.chm::/VI_m.html
lvprop.chm::/VI_m.html
lvprop.chm::/VI_m.html
lvprop.chm::/VI_m.html
lvprop.chm::/VI_m.html
lvprop.chm::/VI_m.html
lvprop.chm::/VI_m.html

the top-level VI is polymorphic, LabVIEW
prints a list of all the instances of the
polymorphic VI including the icon, name,
and path of each instance. Details

Printing:Custom Panel
Border?

Specifies whether to print the front panel
with a border when using the custom
format with one of the print
documentation VI methods. Detalils

Printing:Custom Panel?

Specifies whether to print the front panel
when using the custom format with one
of the print documentation VI methods.
Details

Printing:Default Printer

Gets or sets the name of the default
printer in LabVIEW. Details

Printing:File Wrap Text Length

Maximum number of characters on a
single line in a file. Affects the Print:VI To
HTML, Print:VI To RTF, and Print:VI To
Text methods. Set this property to O to
print all the characters on one line so the
text does not wrap. Details

Printing:JPEG Quality

Percentage value from 0 to 100
specifying the level of quality you want
for the JPEG graphic in VIs printed either
interactively or with the Print:VI To HTML
method. The scale balances image
quality and file size. A value in the 75 to
95 range produces a compressed file
with a high-quality image, and a value
below 50 produces a smaller file size
with a low-quality image. The default is
80. Details

Printing:Method

Gets or sets how LabVIEW prints. Valid
values include 0 (Standard), 1
(PostScript), and 2 (Bitmap). Details

Printing:PNG Compression
Level

Number between 0 and 9 that specifies
the level of compression you want for the
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PNG file for graphics in VIs printed either
interactively or with the Print:VI To HTML
method. The quality of the graphic is not
affected by the compression, but the
graphic file size and speed of
compression are affected by this value.
Valid values range from 0 to 9 and
balance file compression with speed. 0
designates no compression. 1
designates less compression, but faster
speed. 9 designates high compression,
but slower speed. If you enter -1,
LabVIEW selects the best combination of
speed and compression. Details

Project:Projects]

Returns an array of references to each
LabVIEW project in memory. You can
use these references with the Project
properties. Details

Project:Target Item

Returns the associated target item of the
application reference you specify. Details

Remote Panel:Connections To
Clients

Returns an array of clusters containing
connection information about the clients
currently connected to the computer.
Details

Remote Panel:Connections To
Servers

Returns an array of clusters containing
connection information about the servers
to which the computer is currently
connected. Details

Server:Logging Enabled

Specifies whether the TCP interface to
the VI Server is logging operations to a
file. Detalls

Server:Logging File Path

Path of the log file created during TCP/IP
communication. Details

Server:Port

Gets or sets the LabVIEW VI server port.
LabVIEW returns an error if you attempt
to access this property on a remote
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application. Details

Server:Service Name

Gets or sets the service name for the
LabVIEW VI Server. Details

Server:TCP Listener Active

Specifies whether the TCP interface to
the VI Server is currently accepting
connections. Details

Server:TCP/IP Access List

List that describes which TCP/IP
addresses of remote clients may access
the VI server. Detalils

Server:VI Access List

List that describes which VIs on the VI
server are accessible by remote clients.
Details

Web Server:Config File Path

The path of the LabVIEW Web Server
configuration file. Details

Web Server:Default Config
File Path

The path of the Web Server configuration
file that contains the LabVIEW default
configuration. Details

Web Server:HTTP Port

The port to which the built-in Web Server
listens for HTTP requests. Details

Web Server:Logging Enabled

Determines whether the built-in Web
Server logs to a file information about
HTTP requests. Details

Web Server:Logging File Path

Determines where the built-in Web
Server places the log file. Details

Web Server:Read Timeout

Determines how long the built-in Web
Server waits for read operations to
complete when the Web Server reads
HTTP requests from HTTP clients.
Details

Web Server:Root Directory
Path

Specifies the root directory from which
the built-in Web Server loads files for
document requests. Details

Web Server:Server Active

Determines whether the built-in Web
Server is enabled. Detalls




Web Server:TCP/IP Access
List

Sets or gets the TCP/IP addresses that
have access to the Web Server. This
property also sets or gets whether each
address has access to view a VI
remotely, view and control a VI remotely,
or does not have access to the Web
Server. Detalls

Web Server:VI Access List

Sets or gets the VIs that are visible
through the Web Server. This property
also sets or gets whether LabVIEW
allows access to each VI. Details




Application Methods

Installed With: Base Package
View the class hierarchy.

Method

Description

Bring To Front

On Windows and Mac OS, brings the
application windows to the front.
Details

Browse DataSocket

Launches the DataSocket Browser
dialog box to establish a connection to
a DataSocket item. Details

Clipboard:Read From Clipboard

Reads text from the system clipboard.
Details

Clipboard:Restore

Restores data to clipboard that was
saved by a previous Clipboard:Save
method call. Details

Clipboard:Save

Saves the data currently on the
clipboard to be restored later. Details

Clipboard:Write to Clipboard

Writes text to the system clipboard.
Details

Responsiveness:Information

Connection Checks if the VI Server connection is
Responsiveness:Check responsive. Details
Connection Gets and sets how often LabVIEW

checks if a VI Server connection is
responsive. Details

Debug Connection:Close
Debug Connection

Closes the connection to the
application or shared library specified
in Debug Name. Detalils

Debug Connection:List
Applications or Shared Libraries

Returns the list of applications and
shared libraries you can debug on the
computer specified by Server
Address. Details

Debug Connection:Open Debug
Connection

Opens a connection to the application
or shared library you can debug.
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Details

Get VI Version

Returns the version of LabVIEW in
which the VI was last saved. LabVIEW
does not open the VI when retrieving
the version information. If you specify a
path to a file that is not a VI, LabVIEW
returns error 6559. Details

LabVIEW Class:Create

Creates a new LabVIEW class. Details

LabVIEW Class:Open

Opens the LabVIEW class specified by
Path. Details

Library:Create

Creates a new LabVIEW project
library. Detalls

Library:Deploy Libraries

Deploys library files to the specified
computer. Details

Library:Deploy Library

Deploys a library file to the specified
computer. Details

Library:Get File LabVIEW
Version

Returns the version of LabVIEW in
which the library was created. Details

Library:Open

Opens the LabVIEW project library
specified by Path. Details

Library:Undeploy Library

Removes a library from a target.
Details

LVRT:Disconnect From Slave

Disconnects the open connection
between LabVIEW and an RT target.
Details

Mass Compile

Loads and compiles all the Visin a
directory, including any Vis in
subdirectories, for the specified
application instance. Details

NI Security:Get Access Rights

Validates the access control list with
the current application user logged in.
Details

NI Security:Invoke Login Dialog

Invokes the NI Security Login dialog
box programmatically. Details
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NI Security:Login

Logs a user into the NI domain. Details

NI Security:Logout

Logs the current user out of the NI
domain and reverts to the default user.
Details

Palettes:Refresh

Updates the Controls and Functions
palette set programmatically. To update
the palette set, place the
Palettes:Refresh method on the block
diagram to the right of the Write Palette
VI and run the VI. This method is
similar to the Save Changes button on
the Edit Controls and Functions Palette
Set dialog box. Details

Project:New

Creates a new, empty LabVIEW
project. You also can use the Project
Explorer window to create a new
project. Details

Project:Open

Loads a LabVIEW project from disk. If
the project is already in memory, this
method returns a reference to the
existing project. You can use this
reference with the Project properties.
You also can select File»Open Project
to navigate to and open a project.
Details

Remote Panel:Client Release
Control

Returns control of the remote front
panel to the server. The server grants
control to the next client in the queue
or regains control if no requests are in
the queue. Details

Remote Panel:Client Request
Control

Requests control of the front panel of a
VI on the server computer. Details

Remote Panel:Close
Connection To Server

Closes a connection to a VI on the
server computer. Details

Remote Panel:Open

Opens a connection to a server and
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Connection To Server

displays the front panel of a VI on the
server computer. You also can request
control of the front panel. Details

Scene:Drawable:Geometry:New
Box

Creates a geometry that you can use
to set an object in a 3D scene to a box.
Details

Scene:Drawable:Geometry:New
Cone

Creates a geometry that you can use
to set an object in a 3D scene to a
cone. Details

Scene:Drawable:Geometry:New
Cylinder

Creates a geometry that you can use
to set an object in a 3D scene to a
cylinder. Detalils

Scene:Drawable:Geometry:New
Height Field

Creates a new height field in a 3D
scene. Details

Scene:Drawable:Geometry:New
Mesh

Creates a new mesh in a 3D scene.
Details

Scene:Drawable:Geometry:New
Sphere

Creates a geometry that you can use
to set an object in a 3D scene to a
sphere. Details

Scene:Drawable:New Text

Creates a new text object in a 3D
scene. Detalls

Scene:New Clip Plane

Creates a new clip plane in a 3D
scene. Details

Scene:New Light

Creates a new light in a 3D scene.
Details

Scene:New Object

Creates a new object in a 3D scene.
Details

Scene:New Texture

Gets a reference to a texture to apply
to a geometry in a 3D scene. Detalils

Scene:New Window

Creates a new window in which
LabVIEW generates the 3D scene.
Details

Scene:Read Scene File

Reads a 3D scene file that you create
with the Scene:Write Scene File
method. The file being read must have
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a .lvsg extension. Details

Scene:Write Scene File

Writes a new 3D scene file. The
filename must end with a .lvsg
extension. Detalls

Statechart:Create

Creates a new statechart. You must
save the statechart to disk. Detalls

Statechart:Open

Opens the statechart specified by
Path. Details

VlIs Strings:Export

Exports to a tagged text file all the User
Interface related strings of the VIs
specified by VI Array. Details

VIs Strings:Import

Imports to a tagged text file all the User
Interface related strings of the VIs
specified by VI Array. Details

Web Server:Configure

Configure the LabVIEW Web server
with the given file. If the file is unwired
the Web server will be reset to the
default configuration. Details

XControl:Create

Creates an XControl library. Details

XControl:Open

Opens an XControl library and returns
a reference to it. Details
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Application Events
Installed With: Base Package

View the class hierarchy.

Event Description

Application|When registered for in a VI running inside a LabVIEW

Instance |project, generated when the application instance of the

Close project is closed for any reason, such as when you close the
Project Explorer window, when you select File»Close All
or File»Quit, or when you run a VI that executes the Quit
LabVIEW function. When registered for in a VI running
outside a project, generated when you exit LabVIEW
through the user interface or with the Quit LabVIEW
function. Details

Application|When registered for in a VI running inside a LabVIEW

Instance |project, this event is generated when the application

Close? instance of the project is closed interactively, such as when
you close the Project Explorer window or when you select
File»Close All or File»Quit. When registered for in a VI
running outside a project, this event is generated only when
you exit LabVIEW through the user interface. Details

NI Security|Generated when the user logs into the application. Details

User

Change

Timeout |Occurs when the Event structure times out. Wire a value to
the Timeout terminal at the top left of the Event structure to
specify the number of milliseconds the Event structure
should wait for an event to occur before generating a
Timeout event. Details
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VI Properties

Installed With: Base Package

View the class hierarchy.

You can set these properties for a VI in edit mode by selecting File»VI
Properties and other menu items. If you do not wire a refnum to the
reference input of the Property Node, LabVIEW gets or sets the property

for the current VI.

Property

Description

Auto Logging:Log at
Finish

Indicates whether to write front panel values to a
datalog file after the VI runs. Detalls

Auto Logging:Log File
Path

Path of the datalog file in which front panel data
and a time stamp are written. Details

Auto Logging:Print at
Finish

Indicates whether to print the front panel after
the VI runs. Details

Automatic Error
Handling

If TRUE, enables automatic error handling for a
V1. Details

C Code
Generation:Expression
Folding

Generates better performing and more efficient
code by collapsing groups of nodes into single
expressions that are easily recognized by C
compilers. Details

C Code
Generation:Generate
C Function Calls

Generates the calling interface to the Vl as C
function calls without any default data
initializations, which can reduce the code size by
as much as 50% for a small VI. An error occurs
if any input or output to the VI is unwired when
you build the embedded VI into an embedded
application. To generate C function calls using
this property, you also must generate serial only
code. Details

C Code
Generation:Generate
Guard Code

Generates extra code to prevent common
coding mistakes that can cause an embedded
application to crash or function incorrectly. For
example, guard code can prevent dividing by
zero or indexing out of range in an array. Guard
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code makes an embedded application slightly
larger and slower. Details

C Code Generates C code without any floating-point

Generation:Generate |declarations or operations. This option creates a

Integer Only smaller embedded application because it does
not link any floating point-specific libraries.
Details

C Code Generates C code without cooperative

Generation:Generate |multitasking code. Removing this cooperative

Serial Only multitasking code makes the C code easier to
read and usually runs much faster. However,
you lose parallel execution behavior. This
execution behavior most closely resembles
subroutine priority VIs in LabVIEW for Windows.
Details

C Code Inlines subViIs into callers, which can eliminate

Generation:Inline
SubVI

overhead and increase code optimization.
Inlining subVIs is most useful for small subVis,
VIs with many calls in a loop, or subVIs with only
one call site. Details

C Code Generates C Code for subVI calls with as little
Generation:Optimize |default data initialization as possible. Details
SubVI Calls

C Code Uses stack variables rather than heap variables

Generation:Use Stack
Variables

to represent signals in the generated C code,
which enables better C compiler optimizations
and makes the C code faster. Detalils

Callees' Names

Returns a list of all the subVIs or callees in a VI.
Details

Callers' Names

Returns a list of all the loaded VIs that call the
referenced VI. Details

Connector Pane:Set

Connector pane of the VI. This property
configures the VI referenced by the Property
Node with the same connector pane layout as
the VI referenced by the input. The two VIs must
have the same number of parameters, with




identical data types and names. If they do not,
the Property Node returns an error. You can use
this property to dynamically configure a VI
connector pane. For example, you can open a
strictly typed reference to another VI that has the
connector pane you want. Then, you can open a
reference to the VI whose connector pane you
want to set, wire that reference to a property
node, then wire the strictly typed reference to
this property. This sets the connector panes the
same. Details

Edit Mode On Open

If TRUE, the VI opens in edit mode. If FALSE,
the VI opens in run mode, and the title bar,
menu bar, and toolbar do not appear. Details

Execution:Allow
Debugging

If TRUE, you can use debugging tools on the VI.
Set this property to FALSE to reduce memory
requirements and to improve performance
slightly for the VI. Detalils

Execution:Close After
Call

Indicates whether to close the front panel after
the VI runs. Details

Execution:Is Reentrant

Indicates whether a VI can be reentrant. Details

Execution:Preferred
Exec System

Indicates the execution system in which the VI
runs. Details

Execution:Priority

Indicates the priority of the VI when it runs in
parallel with other tasks. Details

Execution:Reentrancy
Type

Indicates the type of reentrancy LabVIEW uses
for a reentrant VI. Details

Execution:Run When

Indicates whether to run the VI when it opens.

Opened Details
Execution:Show Front |Indicates whether to show the front panel when
Panel On Call the VI is called. Details

Execution:Show Front
Panel On Load

Indicates whether to show the front panel when
the VI is loaded. Details

Execution:State

Indicates the execution state of the VI. Detalls

Execution:Suspend

Indicates whether the VI should be suspended
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On Call

when it is called as a subVI. Use this property
carefully with reentrant VIs. Details

Expand When
Dropped As SubVI

Expands to show terminals when dropped as a
subVI. Details

Front Panel
Window:Allow
Runtime PopUp

Indicates whether to display shortcut menus for
front panel objects while the VI runs. If you do
not display default run-time shortcut menus, you
can continue to include customized shortcut
menus. Details

Front Panel
Window:Behavior

Sets the behavior of the front panel window.
Valid values include 0O (Invalid), 1 (Default), 2
(Floating), 3 (Floating/Auto-Hide), and 4 (Modal).
Details

Front Panel
Window:Closeable

Indicates whether the close button in the title bar
is disabled and the Close item in the File menu
is disabled. Details

Front Panel
Window:Custom Title

Indicates whether the VI has a custom title
string. Write FALSE to remove the custom title
string. Details

Front Panel
Window:Highlight
Return Button

Indicates whether to highlight Boolean controls
that have a shortcut key of <Enter>. Details

Front Panel Window:ls
Frontmost

Writing TRUE to this value brings the front panel
to the front. This property applies only in the
application instance of the calling VI. Writing
FALSE to this value has no effect. If you read
this property, it indicates whether the front panel
window is the front window (ignoring floating
windows). Details

Front Panel
Window:Keep Window
Proportions

Indicates whether the front panel window adjusts
its size in proportion with a change in monitor
resolution. The window changes size so it
covers the same percentage of the screen that it
covered at its original resolution. Details

Front Panel
Window:Minimizable

Indicates whether the user can minimize the
front panel window while the VI runs. Details
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Front Panel
Window:Minimum Size

Minimum size of the front panel window in
pixels. If Front Panel Window:Resizable is
TRUE, the user cannot resize the front panel
smaller than the width and height you wire to
this property. Details

Front Panel
Window:Monitor

The monitor on which the front panel window
appears, if you have multiple monitors. The
value 0 is the primary monitor. Detalils

Front Panel National Instruments recommends you use the

Window:Open Front Panel:Open method instead of this
property to open the front panel window.
Reading this property indicates whether the
window currently is open. Details

Front Panel The four elements in the cluster are the top, left,

Window:Panel Bounds

bottom, and right values of the interior portion of
the front panel, not including the scroll bars, title
bar, menu bar, and toolbar. The cluster elements
are in global screen coordinates, which are the
numbers that refer to coordinates within a
computer monitor's screen (rather than an open
window). You can set this property only for VIs
with open front panels. If you do not want the VI
for which you want to set this property to appear
to users, use the Hidden state of the Front Panel
Window:State property to hide the front panel of
the VI. Detalls

Front Panel Indicates whether the user can resize the front

Window:Resizable panel window while the VI runs. Details

Front Panel Sets the VI to use a semi-transparent window

Window:Run VI style when running. Set the level of transparency

Transparently using the Front Panel Window:Transparency
property. Details

Front Panel Indicates whether to display the menu bar on the

Window:Show Menu
Bar

front panel while the VI runs. Details

Front Panel
Window:State

Current state of the front panel window. Valid
values include 0 (Invalid), 1 (Standard), 2
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(Closed), 3 (Hidden), 4 (Minimized), and 5
(Maximized). Details

Front Panel
Window:Title Bar
Visible

Indicates whether to display a title bar on the
front panel while the VI runs. Details

Front Panel String that appears in the title bar. This string
Window:Title does not have to match the VI filename. Details
Front Panel Sets the window transparency level of the VI.

Window:Transparency

The level of transparency is a percentage where
0 is opaque and 100 is invisible. This property
returns an error if you specify a value outside
the range of 0 to 100. If you set the transparency
level to 100, the VI becomes invisible and
uncontrollable from the front panel. You must
stop the VI on the block diagram for the front
panel of the VI to become visible. You must set
the Front Panel Window:Run VI Transparently
property to TRUE for this property to have any
effect. The default value for the Front Panel
Window:Run VI Transparently property is
FALSE, in which changing this property has no
effect. Details

Front Panel
Window:Window
Bounds

The four elements in the cluster are the top, left,
bottom, and right values of the front panel
window, which includes the interior region, scroll
bars, title bar, menu bar, and toolbar. They are in
global screen coordinates, that is, the numbers
refer to coordinates within a computer monitor's
screen (rather than an open window). You can
set this property only for VIs with open front
panels. If you do not want the VI for which you
want to set this property to appear to users, use
the Hidden state of the Front Panel
Window:State Property to hide the front panel of
the VI. Detalls

Front Panel

Reference to the front panel of a VI. Details

Help:Document Path

Path or symbolic path to an HTML file (.htm or
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.html) or compiled help file (.chm or .hlp) to which
the VI is linked. Details

Help:Document Tag

Index keyword or HTML filename for a topic in
the compiled help file to which the VI is linked.
Details

History:Always Add
Comments At Save

Indicates whether to add a comment to the VI
revision history every time the VI is saved.
Details

History:Entire Text

Returns all the text that was added to the VI
revision history. Details

History:Prompt for
Comments At Close

Indicates whether to prompt for a VI revision
history comment when the VI closes. Details

History:Prompt for
Comments At Save

Indicates whether to prompt for a VI revision
history comment when the VI is saved. Details

History:Record
Application Comments

Indicates whether to add comments to the VI
revision history when certain events occur, such
as conversion to a new version of LabVIEW,
subVI changes, and changes to the name or
path of the VI. Details

History:Revision
Number

Current revision number of the VI. Details

History:Use Defaults

Indicates whether to use the global default
history or to use the values entered in other
history properties. Details

Is Clone VI Returns TRUE if the VI is a clone of a reentrant
VI. Details

Is Instance Returns whether or not the VI is an Express VI
instance. Details

Is Probe Returns TRUE if the VI is running as a probe
and the probe VI is open. Detalils

Library Returns the name of the LabVIEW project

library, XControl, or LabVIEW class that owns
the VI. If no library, XControl, or class owns the
VI, the property returns Not a Refnum. Details
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Metrics:Block Diagram
Loaded

Specifies whether the block diagram of the VI is
in memory. The block diagram can be in
memory even if the window is not open. Details

Metrics:Code Size

Amount of memory used for VI code in bytes.
Details

Metrics:Front Panel
Loaded

Specifies whether the front panel of the VI is in
memory. The front panel can be in memory even
if the window is not open. Details

Metrics:Size of Block
Diagram

Size of the block diagram in bytes. Detalils

Metrics:Size of Front
Panel

Size of the front panel in bytes. Details

Metrics:Total Data
Size

Amount of memory allocated for data in bytes.
Details

Modifications:Block
Diagram Mods Bitset

Indicates whether changes were made to the
block diagram since the VI was saved or
opened, depending on which was last. If the
value is zero, no changes were made. If the
value is nonzero, changes were made. Details

Modifications:Front
Panel Mods Bitset

Indicates whether changes were made to the
front panel since the VI was saved. If the value
is zero, no changes where made. If the value is
nonzero, changes were made. Details

Modifications:VI
Modifications Bitset

Indicates if changes were made to the VI since
the VI was saved. If the value is zero, no
changes were made. If the value is nonzero,
changes were made. Details

Owning Application

Returns a reference to the application that owns
the VI. Be sure and close this reference
afterward. Details

Printing:Block Diagram
Scaling?

If TRUE, LabVIEW scales the block diagram to
fit on the printed page. Details

Printing:Front Panel
Scaling?

If TRUE, LabVIEW scales the front panel to fit
on the printed page. Details

Printing:Header

If TRUE, LabVIEW includes the date printed in
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Content:Date Printed?

the headers for the VI. Use the Printing:Page
Headers? property to set whether LabVIEW
prints the headers for the VI. Details

Printing:Header
Content:Modify Date?

If TRUE, LabVIEW includes the last modified
date in the headers for the VI. Use the
Printing:Page Headers? property to set whether
LabVIEW prints the headers for the VI. Details

Printing:Header
Content:Page
Number?

If TRUE, LabVIEW includes the page number in
the headers for the VI. Use the Printing:Page
Headers? property to set whether LabVIEW
prints the headers for the VI. Details

Printing:Header
Content:VI Icon?

If TRUE, LabVIEW includes the VI icon in the
headers for the VI. Use the Printing:Page
Headers? property to set whether LabVIEW
prints the headers for the VI. Details

Printing:Header
Content:VI Name?

If TRUE, LabVIEW includes the VI name in the
headers for the VI. Use the Printing:Page
Headers? property to set whether LabVIEW
prints the headers for the VI. Details

Printing:Header
Content:VI Path?

If TRUE, LabVIEW includes the VI path in the
headers for the VI. Use the Printing:Page
Headers? property to set whether LabVIEW
prints the headers for the VI. Details

Printing:Margins

Gets or sets the page margins to use when
printing the VI in inches or centimeters. Details

Printing:Page
Headers?

If TRUE, LabVIEW prints headers for the VI.
Use the Printing:Header Content properties in
this class to customize the contents of the
headers. Details

Printing:Page
Orientation

Gets or sets the page orientation to use when
printing the VI. Valid values include O (Portrait),
1 (Landscape), 2 (Rotated Portrait), and 3
(Rotated Landscape). Details

Run-Time Menu Path

When read, this property returns the run-time
menu path of the VI. When written, this property
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updates the run-time menu path of the VI. If the
VI is running when you write this property, it
updates the menu with data from the new path.
Details

Tool Bar:Show Abort
Button

Indicates whether to display the Abort
Execution button on the toolbar while the VI
runs. Details

Tool Bar:Show Free
Run Button

Indicates whether to display the Run
Continuously button on the toolbar while the VI
runs. Details

Tool Bar:Show Run
Button

Indicates whether to display the Run button on
the toolbar while the VI runs. Details

Tool Bar:Visible

Indicates whether to display the toolbar while the
VI runs. Details

VI Clone Name

Name of the clone of a reentrant VI. Returns an
error if the VI is not a clone. Details

VI Description

Description of the VI that appears in the Context
Help window when you move the cursor over
the VI icon and in VI documentation you
generate. Details

VI Name Name of the VI file. You can write this property
only if the VI has not been saved to disk. Details

VI Path Path to the VI file. Details

VI Type Indicates the type of VI. Invalid VI type,

Standard VI, Control VI, Global VI, Polymorphic
VI, Configuration VI, SubSystem, Facade VI,
Method VI. LabVIEW returns the invalid VI type
value for invalid VI references. LabVIEW returns
the SubSystem value for subVIs for the
LabVIEW Control Design and Simulation Module
that you can place only on a simulation diagram.
The Configuration VI type is not supported.
Details
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VI Methods

Installed With: Base Package

View the class hierarchy.

Diagram:Clean Up

Method Description
Abort VI Aborts the VI execution. Details
Block Cleans up the block diagram of the VI by

rearranging and resizing its objects and signals to
improve readability. You also can select
Edit»Clean Up Diagram to clean up the block
diagram. Details

Block Diagram:Get
Image Scaled

Returns an image of the block diagram and scales
it proportionally according to the maximum width
and height you wire to the method. For example, if
the image of the block diagram is 200 by 200 pixels
and you wire a value of 50 to maximum width and
a value of 100 to maximum height, this method
returns an image that is 50 by 50 pixels. If you do
not wire a value to maximum width or maximum
height, the image retains its actual size. Details

Clear History

Clears the revision history of the referenced VI.
Details

Control Value:Get
All

Gets the values of all controls or indicators in a VI
as variant data. This method returns an array of
clusters that contains control and indicator names
and their values as variant data. Use the Variant to
Data function to convert the data to another
LabVIEW data type. Details

Control Value:Get

Gets the value of a named control or indicator as
variant data. Use the Variant to Data function to
convert the data to another LabVIEW data type.
Details

Control Value:Set

Sets the value of a named control or indicator of
the variant. You can wire a value of any data type
to this method. You do not have to use the To
Variant function to convert the data to a variant
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data type. Details

Default Changes the defaults of all controls on the front
Values:Make panel to be the current values. This method is
Current Default available only in edit mode. Details

Default Changes the current values of all controls on the
Values:Reinitialize |front panel to their defaults. Details

All To Default

Disconnect From Disconnects a VI that a LabVIEW project library
Library owns from the owning project library. Detalils

Find Control with Return a reference to the control that currently has
Key Focus key focus. If there is not a control with key focus in

the target VI, Not a Refnum is returned. Details

Front Panel:Center

Specifies whether to automatically center the front
panel window on the computer screen. Details

Front Panel:Close

Closes the front panel window. Details

Front Panel:Get
Image Scaled

Returns an image of the front panel and scales it
proportionally according to the maximum width and
height you wire to the method. This method is
similar to the Front Panel:Get Image method.
Details

Front Panel:Get
Image

Returns an image of the front panel as a flattened
pixmap. Use the Front Panel:Get Image Scaled
method to return an image of the front panel and
scale it proportionally according to the maximum
width and height you wire to the method. Details

Front Panel:Open

Opens the front panel window. If the front panel is
already open, this method changes the state of the
front panel window to the state you wire to this
method. Details

Front Panel:Run-
Time
Position:Centered

Sets a VI to center its front panel every time the VI
runs. Detalils

Front Panel:Run-
Time
Position:Custom

Sets a custom position for the VI to move its front
panel to every time the VI runs. Details
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Front Panel:Run-
Time Position:Get
Position

Returns the position of the run-time window. Details

Front Panel:Run-
Time
Position:Maximized

Sets a VI to maximize its front panel every time the
VI runs. Details

Front Panel:Run-
Time
Position:Minimized

Sets a VI to minimize its front panel every time the
VI runs. Details

Front Panel:Run-
Time
Position:Unchanged

Sets the VI to not move its front panel when the VI
runs. Detalils

Generate C Code
Variant

Contains the code generation attributes (name,
value pairs) that determine how the LabVIEW C
Code Generator generates the C code from the
block diagram. Any attributes you do not set use
the default behavior. Details

Lock State:Get

Returns the lock state of the VI and indicates
whether the password for the VI is in the password
cache. Details

Lock State:Set

Sets the lock state of a VI. If interactive is FALSE
(default), you can use password to either unlock a
password-protected VI or set the password of an
unprotected VI. If interactive is TRUE, LabVIEW
ignores password and displays a dialog box that
prompts you to change the lock state. Details

Print;Panel To
Printer

Prints just the front panel to the current printer. You
cannot use this method to print a block diagram, list
of controls, or polymorphic VI front panel. Details

Print:VI To HTML

Saves the VI information to an HTML file and saves
the graphics in external files. You can use the Open
URL in Default Browser VI to display the HTML file
in the default Web browser. Details

Print:VI To Printer

Prints the VI information to a printer. Details

Print:VI To RTF

Saves the VI information to an RTF file. Details
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Print:VI To Text

Saves the VI information to a text file. You cannot
save the icon, connector pane, front panel, block
diagram, subVI icons, and VI hierarchy to text.
Details

Remote Returns an array of clusters containing connection
Panel:Client information about the clients viewing or controlling
Connections the VI. Detalls

Remote Closes a remote front panel connection to a client.
Panel:Close Details

Connection To

Client

Remote Panel:Lock
Control

Returns control of the front panel to the server and
gueues any requests from clients to control the
front panel. LabVIEW ignores this method if the
front panel is already locked. Detalils

Remote If the front panel is locked, this method grants

Panel:Unlock control to the next client in the queue. If no clients

Control are in the queue, the method unlocks the front
panel. LabVIEW ignores this method if the front
panel is already unlocked. Details

Revert VI Discards changes and reloads a VI from disk.
Details

Run VI Starts the VI execution, similar to the Run button.

This method is different than calling a VI because it
uses the current values of all front panel controls
for execution rather than using data passed in
through parameters. This method also ignores the
Execution:Show Front Panel On Call property of a
VI and the Execution:Close After Call property.
Details

Save:For Previous

Saves a copy of the VI that is readable by
LabVIEW version 8.0 and later. Details

Save:lnstrument

Saves a VI and synchronizes the VI with the edited
version in other application instances before
saving. Details

Save:Run-Time

Saves the run-time menu to a file specified by
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Menu Path. This method works only when the VI is
running. It saves only menu items with valid tags.
Details

VI Icon:Get As Returns the VI icon as a cluster of image data so

Image Data you can draw it as a picture using the Draw

Flattened Pixmap VI or save the image to a file
using the Graphics Formats VIs. Details

VI Icon:Save To File

Saves an image of the VI icon to a file. Details

VI Ilcon:Set From
File

Sets the image of a VI icon from a file. Detalls

VI Icon:Set From
Image Data

Sets the image of a VI icon. Details

VI Strings:Export

Exports the following strings about VI and front
panel objects to a tagged text file: VI name and
description, object caption labels, object free
labels, default data (string, table, path, and array
default data), private data (listbox item names,
table row and column headers, graph plot names,
graph cursor names, graph annotation names, and
tab control page captions), and polymorphic VI
data (instance names in the polymorphic VI and
selector shortcut menus). Details

VI Strings:Import

Imports the following strings about VI and front
panel objects from a tagged text file: VI name and
description, object caption labels, object free
labels, default data (string, table, path, and array
default data), private data (listbox item names,
table row and column headers, graph plot names,
graph cursor names, graph annotation names, and
tab control page captions), and polymorphic VI
data (instance names in the polymorphic VI and
selector shortcut menus). Details
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VI Events
Installed With: Base Package

View the class hierarchy.

Event Description

Key Down |Generated when the user performs keystrokes on the
keyboard. Details

Key Generated when the user performs keystrokes on the

Down? keyboard. Details

Key Generated at regular intervals when the user presses and

Repeat holds a key anywhere on the front panel. Details

Key Generated at regular intervals when the user presses and

Repeat? |holds a key anywhere on the front panel. Details

Key Up Generated when the user releases a key on the keyboard.
Details

Menu Generated when the user opens a menu using the mouse or

Activation?|keyboard shortcut, for example, <Alt-F> to open the File
menu. Also generated when the user presses shortcut keys
to activate a menu item, for example, <Ctrl-C> to copy text.
Details

Menu Generated when the user selects an application item from

Selection |the LabVIEW menu, such as Help»Show Context Help.

(App) Use the Menu Selection (User) event to generate an event
when the user selects a user-defined menu item. Details

Menu Generated when the user selects a user-defined item from

Selection |the LabVIEW menu. Use the Menu Selection (App) event to

(User) generate an event when the user selects an application
menu item. Details

Menu Generated when the user selects an application item from

Selection? |the LabVIEW menu, such as Help»Show Context Help.

(App) Details

Mouse Generated when the cursor enters the bounds of the front

Enter panel. Details

Mouse

Generated when the cursor leaves the bounds of the front
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Leave

panel. Details

Panel Generated when the user tries to interactively close the front
Close panel of a VI by selecting the Close item in the File menu or
by clicking the close glyph on the window border. Details
Panel Generated when the user tries to interactively close the front
Close? panel on a VI by selecting the Close item in the File menu
or by clicking the close glyph on the window border. Details
Panel Generated when the user sizes the front panel by clicking
Resize and dragging the window frame, minimizes or maximizes the

front panel, or restores the front panel to its original size
from a maximized or minimized state. Detalils




FacadeVI Properties

Installed With: Base Package
Inherits from VI. View the class hierarchy.

No properties are specific to this class.



FacadeVl Methods

Installed With: Base Package
Inherits from VI. View the class hierarchy.

No methods are specific to this class.



FacadeVIl Events

Installed With: Base Package
Inherits from VI. View the class hierarchy.

Change

Event |Description

Data Generated on the Facade VI when the value of the XControl

Change |changes as a result of writing to its terminal, local variable, or
Value property. LabVIEW calls the Facade VI with the new
value. Detalls

Direction|Generated on the Facade VI when the direction of the

Change |XControl changes from control to indicator or vice versa.
Details

Display |Generated on the Facade VI when the display state of the

State XControl changes because the user invoked a property or a

Change |method on the XControl. Details

Exec Generated on the Facade VI when the execution state of the

State VI that owns the XControl changes from idle to running or vice

versa. Details
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MethodVI Properties

Installed With: Base Package
Inherits from VI. View the class hierarchy.

No properties are specific to this class.



MethodVI Methods

Installed With: Base Package
Inherits from VI. View the class hierarchy.

No methods are specific to this class.



PolymorphicVI Properties

Installed With: Base Package
Inherits from VI. View the class hierarchy.

No properties are specific to this class.



PolymorphicVIl Methods

Installed With: Base Package
Inherits from VI. View the class hierarchy.

No methods are specific to this class.



Project Properties
Installed With: Base Package

View the class hierarchy.

Property |Description

Active If the Project Explorer window has focus, returns an array of

ltems In references to the selected project items in the Project

Tree Explorer window. If the Project Explorer window does not
have focus, returns a reference to the project item
associated with the VI window that has focus. You can use
these references with the Projectitem properties. Details

Application |Returns the application reference for the LabVIEW project.
You can use this reference with the Application properties.
Details

Description|Gets or sets the description of the LabVIEW project. You
also can use the Project Properties page to set the project
description. Details

Items View |Show or hide the Items page in the Project Explorer

Active window. Details

My Returns a reference to My Computer in the Project

Computer |Explorer window for the LabVIEW project. You can use this
reference with the Targetltem properties. Details

Name Gets the name of the LabVIEW project. If the project has
been saved, this property returns the filename with the file
extension. If the project has not been saved, this property
returns untitled project x and you can write to this property to
change the name. Detalils

Path Gets the path to the saved LabVIEW project on disk. This
path includes the filename of the project. Details

Root Returns a reference to the project root in the Project
Explorer window. The project root is the top item that
represents the LabVIEW project in the Project Explorer
window. You can use this reference with the Projectltem
properties. Details

Selected |Returns an array of references to the project items currently
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Items in selected in the Project Explorer window. You can use these
Tree references with the Projectltem properties. Details

Targets Returns an array of references to all targets in the current
LabVIEW project. You can use these references with the
Targetltem properties. Details

Window |Returns the state of the Project Explorer window. Details
State
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Project Methods
Installed With: Base Package

View the class hierarchy.

Method

Description

Close Window

Closes only the Project Explorer window. This method
does not close VI windows. Details

Close

Closes a LabVIEW project and all references to all items
in the project. This method also closes the Project
Explorer window if it is open and closes any VIs that
are open in any application instance owned by the
project. You also can select File»Close All to close the
project and the Project Explorer window. Details

Deploy ltems

Deploys an array of items in the LabVIEW project.
Details

Local Project
Settings:Delete
ltem

Deletes an item from the local project settings file.
Details

Local Project
Settings:Delete
Section

Deletes an entire section from the local project settings
file. Details

Local Project
Settings:Get
ltem

Gets an item from the local project settings file. Details

Local Project
Settings:Has
ltem

Determines if an item exists in the local project settings
file. Details

Local Project
Settings:Has
Section

Determines if a section exists in the local project
settings file. Detalls

Local Project
Settings:Set
ltem

Sets an item in the local project settings file. Detalils

Open Window

Displays the Project Explorer window. Details
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Refresh Auto-
Populating
Folders

Force all auto-populated folders on this project to
update their contents to match the disk. Details

Save As

Allows a LabVIEW project to be saved as a different
name or to a different location. This method also
enables the save operation to copy all of the contents of
the project to the new location. If the parameter for the
project items is left blank, LabVIEW will copy everything
to the new location, otherwise LabVIEW will copy only
the items specified. Details

Save Copy

Saves a copy of the project to a new location on disk,
where all referenced Vls are in the same location.
Details

Save For
Previous

Saves a copy of the LabVIEW project that is readable
by LabVIEW 8.0 and later. This method is similar to the
LabVIEW Version selection in the Save for Previous
Version dialog box. Details

Save

Saves the LabVIEW project to the path that the project
was previously saved to or loaded from or to a specified
path. Details



lvconcepts.chm::/Using_LabVIEW_Projects.html
lvconcepts.chm::/Using_LabVIEW_Projects.html
lvdialog.chm::/Save_Options.html

Projectitem Properties
Installed With: Base Package

View the class hierarchy.

Property Description

Children(] Returns an array of references to all children of the
referenced project item. You can use these references
with the Projectltem properties. Details

Contains Returns TRUE if this item or items beneath this item in

Conflicts? the project tree are in conflict. Details

Display Gets as a string the name of the project item as the name

Name appears in the Project Explorer window. Details

Enabled Applicable in 110 only. Tasks and program VIs can be set
to Enabled, in which case they will be deployed and run
on the Controller. Details

Find:Callers |Returns an array of references to all project items that

reference the project item you select. Details

Find:Conflicts

Returns an array of references to all project items that are
in conflict with the project item you select. Details

Find:ltems  |Returns an array of references to all top-level project

with No items that call no other project items. Details

Callers

Find:Missing |Returns all project items that have a path but do not exist

ltems on disk. Details

Find:SubVIs |Returns an array of references to all project items that are
subVIs of the item you select. Details

Get Auto- Returns the path on disk this auto-populating folder is

populating connected to. Details

Folder Path

HyperLink Gets or sets the address of a hyperlink item. Details

Address

lcon Gets the icon of the project item in the Project Explorer

window using the Icon cluster, which limits size and color
depth. Details
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In Conflict?

Returns TRUE if this item conflicts with another item with
a different path under the same target. Details

Item ID Gets the item ID of the referenced project item as a string.
You can use this item ID to uniquely identify the
referenced item even if the path, name, or location in the
Project Explorer window changes. Details

Library Item |Returns the type of the project item as it exists in the

Type:String  |project library as a string. Use the Library Item:Type
property to return the type as a GUID. Details

Library Gets the type of the project item as it exists in the project

ltem:Type library as a GUID string. Use the Library Iltem Type:String
property to return the type as a human-readable string.
Details

Name Gets the name of the referenced project item as it is
saved in the file. Details

Parent Returns a reference to the parent of the referenced
project item. You can use this reference with the
Projectltem properties. Details

Path Gets the path of the referenced project item. Details

Project Returns a reference to the LabVIEW project to which the
referenced project item belongs. You can use this
reference with the Project properties. Detalils

Target Returns a reference to the target that contains the
referenced project item. You can use this reference with
the Targetltem properties. Details

Type GUID |Gets the type of the project item as a GUID string. Use
the Type String property to return the type as a string.
Details

Type String |Gets the type of the project item as a string. Use the Type
GUID property to return the type as a GUID. Details

Variable Returns a reference to the variable the referenced project

Reference item references. If the referenced project item is not a

variable item, this property returns Not a Refnum. You can
use this reference with the Variable properties to
configure shared variables programmatically. Details
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VI Reference
No Load

If the project item refers to a VI in memory, this property
returns a reference to the VI. If the project item refers to a
VI not in memory or to something that is not a VI, this
property returns Not a Refnum. You can use this reference
with the VI properties. Detalils

VI Reference

If the project item refers to a VI, this property returns a
reference to the VI. Otherwise, this property returns Not a
Refnum. You can use this reference with the VI properties.
Details

Visible In
Tree

If TRUE, indicates that the Project Explorer window is
visible and ancestors of the project item are expanded in
the Project Explorer window up to the root of the project
item. Details
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Projectitem Methods
Installed With: Base Package

View the class hierarchy.

Method Description

Add File Adds a file at the specified path to the LabVIEW project
with the referenced project item as the parent. You also
can use the Project Explorer window to add a file to a
project. Details

Add Iltem Adds an item that exists in memory to the LabVIEW

From project with the referenced project item as the parent.

Memory Details

Add Item Adds a new project item of the specified type to the
LabVIEW project with the referenced item as the parent.
You also can use the Project Explorer window to add an
item to a project. Details

Convertto |Connect this project item to a folder on disk. Details

Auto-

populating

Folder

Delete Removes the referenced project item from the LabVIEW
project. If the item has children, the children also are
deleted. You also can use the Project Explorer window to
remove items from the project. Details

Get All Returns project items that are descendents of the

Descendents|referenced item. If you specify a value for Type, this
method only returns project items of the specified type.
Details

Stop Auto-  |Disconnect this folder from a folder on disk. Details

populating

Tag:Delete |Removes the named tag from the LabVIEW project item.
Details

Tag:Get Returns an array of tag names of all tags on the

Names referenced project item. Details

Tag:Get Tag |Returns a tag value associated with the project item.
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Details

Tag:Get XML |[Returns the value in an XML tag. Details
Tag

Tag:Set Tag |Sets a tag value associated with the LabVIEW project.
Details

Tag:Set XML |Sets the value of an XML tag associated with the
Tag LabVIEW project. Details




BuildSpecification Properties

Installed With: Base Package
Inherits from Projectltem. View the class hierarchy.

No properties are specific to this class.



BuildSpecification Methods
Installed With: Base Package

Inherits from Projectltem. View the class hierarchy.
No methods are specific to this class.




Library Properties
Installed With: Base Package

Inherits from Projectltem.

View the class hierarchy.

Use these properties to configure LabVIEW project libraries.

Property Description
AlarmsEvents:Database|Specifies the name of the computer where the
Computer alarms and events database resides. Details

AlarmsEvents:Database
Name

Specifies the name of the database where the
Shared Variable Engine logs alarms and
events. Details

AlarmsEvents:Database
Path

Specifies the file path to the database where
the Shared Variable Engine logs alarms and
events. Detalils

AlarmsEvents:Enable

Enables alarms and events logging capability if
set to TRUE. Detalils

AlarmsEvents:Use
DatalLogging Database

Sets the alarms and events database to be the
same as the database that logs data. If set to
TRUE, LabVIEW ignores properties set on the
AlarmsEvents database. Details

DatalLogging:Database
Computer

Specifies the name of the computer where the
database resides. Details

DatalLogging:Database
Name

Specifies the name of the database where the
Shared Variable Engine logs data. Details

DatalLogging:Database
Path

Specifies the file path to the database where
the Shared Variable Engine logs data. Details

DatalLogging:Enable

Enables data logging capability if set to TRUE.
Details

Datal ogging:Lifespan

Sets the lifespan (in days) of the logged data in
the database. If value is 0, then data is always
available, otherwise the database can destroy
data after the number of specified days. Details

Description

Specifies the description of the LabVIEW
project library for the Context Help window.
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Details

Help:Document Path Path or symbolic path to an HTML file (.htm or
.html) or compiled help file (.chm or .hlp) to
which the LabVIEW project library is linked.
Details

Help:Document Tag Index keyword or HTML filename for a topic in
the compiled help file to which the LabVIEW
project library is linked. Details

Localized Name The localized name of the item. Details

Name Returns the name of the library. If the library
has not been saved to disk, you can write to
this property to change the name. Details

Qualified Name Returns the qualified name of the library.
Details
Version The version number of the LabVIEW project

library. Detalls
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Library Methods
Installed With: Base Package

Inherits from Projectltem. View the class hierarchy.

Use these methods to configure LabVIEW project libraries.

Method Description

Apply Icon |This method changes the icon of each VI in the library. The

To Existing |method places the library icon over the existing VI icon.

VI Items This allows you to update VI icons after editing the library
icon. The black and white library icon is used as a mask to
decide what region of the VI icon to overwrite. This method
will load member VIs of the library into memory if they are
not already in memory. Callers may be prompted to
provide VI passwords or to save the loaded VIs. Details

Disconnect |Disconnects a LabVIEW project library that is a sublibrary

From of another project library from the owning project library.

Library Details

Hilite In Shows this library in a project window. If the library is

Project already in a project window, this will show the project

Window window and set focus to the library item in the project. If
the library is already in a library-only project window for
which it is the root item, this will show the library-only
project window. If the library is not in any project window,
this will open a library-only project window containing the
library. Details

Icon:Get Retrieves the icon associated with a LabVIEW project
library. Detalls

Icon:Set Sets the LabVIEW icon file to use for the LabVIEW project
library. Details

Library Deletes a tag from the LabVIEW project library. Details

Tag:Delete

Library Retrieves a list of names for all tags set on the LabVIEW

Tag:Get project library. Details

Names

Library Retrieves a tag set on the LabVIEW project library. Details
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Tag:Get

Library Sets a tag on the LabVIEW project library. Details

Tag:Set

Lock Returns the lock state of the LabVIEW project library and

State:Get |indicates whether the password for the project library is in
the password cache. Details

Lock Sets the level of editing permission for a LabVIEW project

State:Set library, including the password. Details

Save:Copy |Saves a copy of the LabVIEW project library file. Details

Save:For Saves a copy of the project library and all items within the

Previous project library that is readable by LabVIEW 8.0 and later.

This method is similar to the LabVIEW Version selection
on the Save for Previous Version dialog box. Details

Save:Library

Saves the LabVIEW project library file. You also can right-
click the project library in the Project Explorer window
and select Save As from the shortcut menu to save the
project library file. Details

Source Retrieves the access scope for an item that the LabVIEW

Scope:Get |project library owns, such as public or private access.
Details

Source Sets the access scope of an item that the LabVIEW project

Scope:Set

library owns, such as public or private access. Details



lvconcepts.chm::/Project_Libraries.html
lvconcepts.chm::/Project_Libraries.html
lvconcepts.chm::/Project_Libraries.html
lvconcepts.chm::/Project_Libraries.html
lvconcepts.chm::/Project_Libraries.html
lvdialog.chm::/Save_Options.html
lvconcepts.chm::/Project_Libraries.html
lvconcepts.chm::/Project_Libraries.html
lvconcepts.chm::/Project_Libraries.html

LVClassLibrary Properties
Installed With: Base Package
Inherits from Projectltem»Library. View the class hierarchy.




LVClassLibrary Methods

Installed With: Base Package
Inherits from Projectltem»Library. View the class hierarchy.

No methods are specific to this class.



XinterfaceLibrary Methods
Installed With: Base Package
Inherits from Projectltem»Library. View the class hierarchy.

Method Description

Add Ability |Creates a new ability of the specified type. Detalls

Add Method|Creates a new method. Details

New Creates a new property folder and returns a reference to it.
Property Details




XControlLibrary Properties
Installed With: Base Package

Inherits from Projectltem»Library»XInterfaceLibrary. View the class
hierarchy.

No properties are specific to this class.




XControlLibrary Methods

Installed With: Base Package

Inherits from Projectltem»Library»XInterfaceLibrary. View the class
hierarchy.

No methods are specific to this class.




PropertyFolder Methods
Installed With: Base Package
Inherits from Projectltem. View the class hierarchy.

Method |Description

Add Creates a new read or write property VI if you do not wire VI
Property|Path. If you wire VI Path, LabVIEW uses an existing VI as a
\4 property VI. Details




XPropertyFolder Properties
Installed With: Base Package
Inherits from Projectltem»PropertyFolder. View the class hierarchy.

Property |Description

Description|Sets or gets the description of the property folder. Details

Help Tag |Sets or gets the help tag of the property folder. Details

Identifier |Sets or gets the property identifier of the property folder.
Details

Long Sets or gets the long name of the property folder. Details
Name




Targetitem Properties
Installed With: Base Package
Inherits from Projectltem. View the class hierarchy.

Property Description

Application The application instance opened by the target to edit and
run VIs. Details

Build Returns a reference to Build Specifications under the
Specifications |current target in the Project Explorer window. You can
use this reference with the Projectitem properties. Details

Dependencies|Returns a reference to Dependencies under the current
target in the Project Explorer window. You can use this
reference with the Projectltem properties. Details
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Targetitem Methods

Installed With: Base Package
Inherits from Projectltem. View the class hierarchy.

Method Description

Refresh Refreshes Dependencies under this target in the
Dependencies|Project Explorer window. You also can use the Project
Explorer window to refresh Dependencies. Details
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Generic Methods

Installed With: Base Package
View the class hierarchy.

No methods are specific to this class.



Cursor Properties
Installed With: Base Package

Inherits from Generic. View the class hierarchy.

Property

Description

Allow Drag

If TRUE, allows you to drag the cursor. Details

Cursor Color

The color of the cursor, including its point, arrow, and
name. Details

Cursor Index

Array index of point to which the cursor is snapped. This
property can have a value between 0 and the number of
data points minus 1. Details

Cursor Mode

Specifies the way in which the cursor snaps to the plots
in the plot area. Valid values include O (Free), 1 (Single-
plot), and 2 (Multi-plot). Details

Cursor Name
Visible

If TRUE, displays the cursor name in the plot area.
Details

Cursor Name

Text displayed in the plot area that is associated with
the cursor. Details

Cursor Plot

Plot with which the cursor is associated. If Plot is —1, the
cursor snaps to all plots in the plot area. You can move
the cursor to the nearest data point along any plot in the
plot area. Details

Cursor Point
Style

The symbol that, in combination with Style, is drawn at
the focal point of the cursor. Valid values are 0-16, as
shown on the shortcut menu of the plot legend from top-
left to bottom-right. Details

Cursor Position

Position of cursor in terms of X-Y coordinates. Detalls

Cursor
Position:Cursor
X

The X coordinate of the cursor in the plot area.
Position:X is in the coordinate system of the X Scale
value that is associated with the cursor or plot. Details

Cursor
Position:Cursor
Y

The Y coordinate of the cursor in the plot area.
Position:Y is in the coordinate system of the Y Scale
value that is associated with the cursor or plot. Details

Cursor

Color of the cursor row selected in the cursor legend.




Selection Color

Details

Cursor Style

The symbol that, in combination with Point Style, is
drawn at the focal point of the cursor. Valid values are O-
8, from top-left to bottom-right, as shown when you
right-click a cursor in the cursor legend and select
Attributes»Cursor Style from the shortcut menu.
Details

Line Style

Specifies the line style of the active cursor. Valid values
are 0—4, as shown on the shortcut menu of the plot
legend and on the Cursors page of the Properties
dial